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Downloading Exercise Files 
Exercise files can be downloaded from the Cheryl Price web site as follows: 
 

 

1 In your web browser, type: www.cherylprice.co.nz 

2 Press Enter on the keyboard to display the Cheryl Price website. 

3 Click on the Resources tab as shown at the right. 

4 Under the Learning Series Books heading click on  Learning Word 2010  

5 

Under the Exercise Files heading click on the underlined blue hyperlink, ie 

Learning Word 2010 Free Download 
The File Download dialog box will display.   

6 If you have Winzip use the following instructions otherwise move to step 7. 

 a Click on . 

 
b Click on the  of the  button. 

 c If My Documents folder is not displayed click on Set default unzip folder at the bottom of 
the list.  Ensure My Documents is selected then click on Select Folder. 

 d  Click on the  of the  button and click on the My Documents folder.  The files will 
be unzipped. 

7 Click on and ensure My Documents folder is displayed.  Click on  

8 

Click on Open Folder which will display My Documents folder.  Right click on the zipped 
exercise file and select Extract All. Click on Extract.  A folder will be created containing the 
exercise files.   

You will need to double click on this folder to use the exercise files in this book. 
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Changing Defaults 
Default settings may have already been changed in your Word 2010 program.  If not, you can use 
the following instructions to change these. 

Font and Font Size 
You can check if the font and font size have been changed by looking  at the Font box on the 
Home tab.  If it shows  then it has not been altered.  Change the default font to 
Arial 11 pt as follows: 

1 Click on the Font Dialog Box Launcher  which will display the 
Font dialog box. 

2 Change the Font: to Arial and the Size: to 11 pt. 

3 Click on . 

4 Ensure the following option is selected for the font to be applied to All documents based on 
the Normal template.  

 
5 Click on OK then on OK from the Font dialog box. 

Spacing 
Click on the Page Layout tab and if 10 pt Spacing After is displayed as shown at the 
right then this has not been altered.  Remove 10 pt spacing as follows. 

1 Click on the Paragraph Dialog Box Launcher  which will display the 
Paragraph dialog box.   

2 Change the Spacing After: to 0 pt as shown at the right.  

3 Click on .  Ensure All documents based on the Normal template is 
selected then click on OK.  Click on OK from the Paragraph dialog box. 

Margins 
Click on the Page Layout tab then click on the Page Setup Dialog Box Launcher 

 which will display the Page Setup dialog box.  If margins are 
displayed as 3.17 cm change them as follows.  (If they have been changed, click on Cancel.) 

1 The Top: margin will be selected, ie .  Type:  2.54 then press the Tab 
key.  Repeat this until the margins are displayed as shown below. 

. 

2 Click on .  Ensure All documents based on the Normal template is selected then 
click on OK.  Click on OK from the Paragraph dialog box. 
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© Cherylprice.co.nz Limited SECTION 1    1 

 
 

Microsoft Word 2010 Basics 
Editing, Spelling and Grammar 
Text, Paragraph and Page Formats 
Print Preview, Printing 

 
 
 

 
Learning Outcomes 
 
At the end of this section you should be able to -  
 

 Use the basic features of Word 2010, eg saving, opening, printing 

 Select text, edit, move and copy text 

 Check spelling and grammar, use Find and Replace options 

 Apply text formatting, eg fonts, font sizes, bold, italics  

 Achieve consistency, eg use of Format Painter, Repeat key  

 Use paragraph formats, eg alignment, line spacing, indents, tabs  

 Apply page layout options, eg margins, orientation, paper sizes  

 Print preview, print 
 

  

Section 

1 
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2    SECTION 1 © Cherylprice.co.nz Limited 

What is Microsoft Word? 
Microsoft Word is a word processing program that allows you to create text and/or graphics using a 
keyboard which is displayed on screen (referred to as “soft copy).  The document is then saved onto 
the hard disk in your computer system.  A document can be opened on screen and edited and 
formatted (as many times as necessary).  A “hard copy” can be produced by sending the document to 
the printer. 

A word processing program generally includes the creation of - 

 General correspondence, eg letters, memos, faxes 
 Reports, travel documents, minutes of meetings, financial documents  
 Advertisements, flyers, brochures 
 Mail merges (ie direct mail), labels, tables 
 Manuals, other documentation 
 

The Process of a Word Processed Document 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

  
Final copy is printed 

(hard copy) 
 

Document is opened on screen.  It can 
then be edited and formatted, saved 

and resaved as many times  
as necessary. 

Document is printed 
(hard copy) 

 

 
23  January 2010 
 
Mr R B Jacobs 
45 Elm Lane 
OREWA 
 
Dear Mr Jacobs 
 
As requested I am enclosing information on 
Elf Computer Systems.   
 
Please let me know if I can be of further 
assistance. 
 
Yours sincerely 
 

 
Sam Corinaldo 
Manager 
 
Encs 

Document is saved onto the 
Hard Disk inside the  

System Unit 

Text is displayed on monitor 
(soft copy) 

Text is copied from paper 
(or keyed in directly via the 

keyboard onto the  
computer monitor) 

 

 
23  January 2010 
 
Mr R B Jacobs 
45 Elm Lane 
OREWA 
 
Dear Mr Jacobs 
 
Thank you for your letter of 15 December 2009.  
I aI am enclosing information as requested by 
you in your email.  Please ddo not hesitate to 
contact me. 
 
Yours sincerely 
 
 
 
Sam Corinaldo 
Manager 
 
Encs 

 
 
 

 

System Unit 
Monitor 

Keyboard Mouse Speakers 

Dkkfj k 
kdjkadjkdkadjfkadjkdjakljdjasdk
ajkadjkadjkdjfkdjfkadjkadjkasdjl
kasdjklasdjlkasdjlksdjfkasdjklsdj
fksdjflksdjflkasdjflksdjfkasdjfklas
djklasdjlkasdjlkadjfkadjfak; 

 
23  January 2010 
 
Mr R B Jacobs 
45 Elm Lane 
OREWA 
 
Dear Mr Jacobs 
 
Thank you for your letter of 15 December 2009.  
I aI am enclosing information as requested by 
you in your email.  Please ddo not hesitate to 
contact me. 
 
Yours sincerely 
 
 
 
Sam Corinaldo 
Manager 
 
Encs 

Dkkfj k 
kdjkadjkdkadjfkadjkdjakljdjasdk
ajkadjkadjkdjfkdjfkadjkadjkasdjl
kasdjklasdjlkasdjlksdjfkasdjklsdj
fksdjflksdjflkasdjflksdjfkasdjfklas
djklasdjlkasdjlkadjfkadjfak; 
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Starting Microsoft Word 
Exercise 1 

1 Click on the Start button   at the bottom left-hand corner of the screen.    

2 Select  from the Start Menu.  

3 Select  from the Programs menu. 

 

4 Select   from the list to start Word 2010.  
 

Microsoft Word will be displayed on screen with a new document, ready for you to enter text. 
 

 
 
 

 
 
 
 

 

The File tab  which contains all basic tasks such as opening, saving and printing a 

document has replaced the Office Button  in Word 2007.   

Microsoft Word 
2010 appears on 
the Start menu after 
you have used it 
three times.  You 
can click on it to 
start Word. 

Ribbon 

Help 

Zoom Controls 

Close 
Quick Access Toolbar 

Vertical 
Scroll Bar 

Vertical 
Scroll Box 

Select 
Browse 
Object 

Title Bar 

File tab 

Minimize Restore Down 

Status Bar 

Insertion point 

Rulers 

 

Group 

 

Tabs 

View 
Ruler 

Note:   

If Rulers are not displayed click 

on the View Ruler button  at 

the top of the Vertical Scroll Bar. 

 

Document Views 
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Quick Access Toolbar 
The Quick Access Toolbar contains commands to Save, Undo and Redo.  
Frequently used commands can be added to this toolbar.   
 

The Ribbon 
The ribbon in Microsoft Word 2010 is divided into groups and used as described below.  (The ribbon 
replaces menus and toolbars that were used in Word 2003). 
 
(a) When you click on a tab, groups will be displayed relating to that particular feature, eg the 

Home tab displays the groups shown below, ie Clipboard, Font, Paragraph, Styles, Editing. 

 
 

 
 
 

(b) Clicking on a down arrow  displays options for that feature, eg 

clicking on the down arrow at the right of Underline  in the Font 
group displays underlining options as shown at the right. 

(c) Clicking on the Dialog Box Launcher  to the right of the group name 
displays the relevant dialog box, from which you can also select the 
same, and additional options, eg clicking on the Font Dialog Box 
Launcher  displays the dialog box for that group as shown below.  
(Click on Cancel to remove the dialog box.) 

 

 
  

Groups 

 

Tabs 
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You can click on the  tab then click on Save. 
 

Tip 

 

Exercise 2 

1 Click on the Orientation down arrow  in the Page Setup group on the Page Layout tab. 

2 Write down the two options that are displayed ...........................................................................  

3 Click to remove options. 

4 Click on the Page Setup Dialog Box Launcher  which displays  ...........................................  
Click on the Margins tab. 

(You will notice there is an Orientation section with the same options as the  button in the 
Page Setup group on the ribbon.) 

5 Click on Cancel. Click on the Home tab. 
 

 

Exercise 3 

Type the text shown below onto your screen using the following instructions: 

1 To type the heading in uppercase press the Caps Lock key.  Type: ONLINE AUCTIONS then 
press the Caps Lock key to turn off uppercase typing. 

2 Press Enter twice to insert a blank line. 

3 For an initial uppercase letter, eg the A of An, hold down the Shift key on the opposite side of 
the keyboard to the letter you are going to type, ie hold down the right Shift key, type A then 
release the Shift key.  Continue typing the remainder of the word. 

(The Shift key is also used to type the top symbols on the keys showing two symbols.) 

4 Type the remaining text.  Leave any typing errors; you will correct these in Exercise 7.  Do not 
press Enter at the end of each line as the text will automatically wrap to the next line.  (Enter is 
pressed once for a new line or twice for a new paragraph.) 

 
 
ONLINE AUCTIONS 

 

An online auction business is a web site where participants bid for products and services 
over the Internet. The process of buying and selling in an auction format is made possible 
through auction software which regulates the various processes involved. 

 
 

 

Saving a document 
Every document you create must be saved with a unique name (called the “file name”) so you can 
recall it to the screen for editing, formatting or printing at a later time.  (Keep file names simple and 
relevant to the document.  You can use letters and numbers, hyphen and underscore.) 
 
Exercise 4 

1 Click on the Save button  on the Quick Access Toolbar  at the top left of 
your screen.  (Note: The Quick Access toolbar may be displayed under the ribbon.) 

 

 

Ctrl S 
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The heading becomes the file name for your document, ie ONLINE AUCTIONS (OR you can 
type another file name on top of the given file name).  

2 Double click on the Learning Word 2010 Exercise Files folder. (This folder has been stored in 
the My Documents folder in the Documents Library.) 

 

3 Click on .  The file name is now displayed at the top of the screen, ie ONLINE 
AUCTIONS – Microsoft Word. 

Once your workbook has been saved pressing Ctrl S saves an updated version of the file. 

Naming Files 
You will find it useful to implement a system for naming files so you can locate them easily at a later 
time.  The name should be descriptive without being too long.  Your company may already have a 
naming convention in place, for example you may be required to add the date the document was 
created to the start or end of the file name.   

Microsoft Office allows up to 255 characters in a file name, and spaces can be included.  You cannot 
use the following characters in a file name: /  \<>  *  ;  :  "  ?  
 

Closing a document 
When you have finished with a document you need 
to close it.  If you haven’t saved any changes, you 
will be prompted to do so (as shown at the right). 
 
Exercise 5 

1 Click on the  tab. 

2 Click on . 
3 Click on Save if asked to save the document. 

Ctrl W 

Note 
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From Backstage view you can double click on Blank document. 
 

Tip 

Creating a new document 
When you first enter Microsoft Word a blank document automatically appears on screen.  When this 
document is closed you will need to create each new document from then on. 

In the following exercise you will also correct basic spelling and grammatical errors. 
 
Exercise 6 

1 Click on .  When you click on the File tab Backstage view will 
appear.  This view allows you to create, open, print and save a document.  
Word options, accessing help along with exiting Word are also available in 
this view.  

2 Click on .  Blank document is selected in Backstage view. 

3 Click on  at the far right. 
 
 

 

4 Type the following text carefully, and exactly as shown below.   

Notice when you type The that it is corrected automatically. 

You will correct errors in steps 5-8 underneath. 

 
 

WHAT IS A TRIATHLON? 
 

A triathlon is an athlettick event that includes swimming, running, and cycling. Teh 
triathlete therefore must frocus his or her training on all three parts. There is 
actually five different lengths of triathlons; they range from short and doable to 
crazylong. (press Enter) 

 

5 Position the mouse pointer in the middle of the word athlettick and click 
the right mouse button (referred to as “right-clicking”), which displays 
the shortcut menu. Click on the first option. 

6 Right-click on frocus and select the correct option. 

Notice that Teh has been corrected automatically. 

7 Correct any other errors you may have made. 

8 Correct There is by right-clicking on is and selecting the correct option, ie are  (The wiggly 
green line under is was not displayed until you pressed Enter at the end of the paragraph.) 

9 Save the document with the file name Triathlon.  (In the Save As dialog box simply type the 
file name Triathlon over the text displayed in the File name: box, ie WHAT IS A 
TRIATHLON? then click on Save.)   

10 Close the document by clicking on the  tab and selecting Close. 
 

Ctrl N 
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In the Open dialog box you can double click on a document to open it. 
 

Tip 

Opening a document 
A document is “opened” when you need to 
recall it to the screen, eg for editing. 
 
Exercise 7 

1 Click on . A list of Recent documents is displayed in Backstage view.   

2 Click on the file name of the document required, ie ONLINE AUCTIONS.   

(If the required document is not displayed on the Recent list click on .  Click on the file 
name of the document required then click on .) 

 

 
 
 

3 Click at the end of the document and press Enter twice to start a new paragraph. 

4 Correct any errors you may have made then type the following: 
 

The most common online auction web site in Australia is EBay and in New Zealand it is 
TradeMe. 

 

5 Click on the Save button  on the Quick Access Toolbar to save and replace the document. 
 
 

Print 
The Print option sends the document directly to the default printer which prints out a paper copy (ie 
“hard copy”) of your document. 
 
Exercise 8 

1 Click on  then click on .   

A preview of how your document will appear when printed is shown to the right in Backstage 
view.  This area is called Print Preview.  (Print Preview was a separate feature in previous 
versions of Word but is now incorporated intoBackstage view in Word 2010.) 

 

2 Click on .  The document will be sent to the printer. 

3 Close the document. 
 

Ctrl O 
 

Ctrl End 
 

Ctrl S 
 

 

Print Preview area Sa
m

pl
e D

oc
um

en
t



© Cherylprice.co.nz Limited SECTION 1    9 

Recent document files and locations are listed in 
Backstage View when you click on  and select 
Recent.  To open a listed file, double click on the file 
name.  This is a useful feature if you are working on a 
file for a lengthy period of time, or if you are using the 
same files often. 
The last four documents opened/created may appear 
above Info; you can also click on one of these to open it. 

 

Tip 

Open Dialog Box 
The Open dialog box is used to retrieve a document that is not displayed on the Recent list.  The 
contents of a particular folder/drive are displayed and the appropriate document (file) can be 
selected. You can then edit, print and format the document as required. 
 
Exercise 9 

1 Click on  then click on .  The Learning Word 2010 Exercise Files folder 
displays all the retrievable Word documents.  If this folder is not displayed do the following: 

a Click on the  next to  under Libraries in the Navigation pane.  A list of 
folders displayed in the Documents library will appear.   

b Click on the  next to .  

c Click on .  

2 Click on  from the Views button  at the top of the dialog box and select . 

 

The dialog box displays: 

 The name of the active folder - currently Learning Word 2010 Exercise Files. 
 A list of files stored within the Learning Word 2010 Exercise Files folder. 
 The type of files currently selected, ie All Word Documents. 

 

3 Click on the file name Africa.   

4 Click on .  (To quickly open a file from the Open dialog box, double click on the file 
name.) 

 
   

 

  

Navigation  
pane 

Address bar - 
displays the 
current folder 

List of files stored 
within the active 
folder 

Views button 

Type of files 
displayed 
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Zoom 
You can zoom in to get a close-up view of your document or zoom out to see more of the page at a 
reduced size.  The Zoom controls on the Status Bar are located at the bottom right of your screen.   
 

 
 
 
 
You will notice that the Zoom Slider is in the middle of the bar, ie at 100% view.   

The Zoom controls are used as follows: 

(a) Drag the Zoom Slider to the left to reduce the size of your document. 
(b) Drag the Zoom Slider to the right to enlarge the size of your document.   

OR 

(a) Click on the Zoom Out button to reduce by increments of 10%.  
(b) Click on the Zoom In button to enlarge by increments of 10%. 
 
 

Exercise 10 

1 Drag the Zoom Slider to the left, to the middle, to the right and then back to the middle (ie 
100%). 

2 Click on the Zoom Out button three times to zoom to 70%. 

3 Click on the Zoom In button three times back to 100% then another three times to 130%. 

4 Change to 100% view.   

5 Click on the View tab which will display additional zoom options. 

 

6 Click on , , , then . 

7 Click on  which displays the Zoom dialog box.  Click in 
the Many pages: option and drag across the top four page icons 
as shown at the right.  (This will display four pages across your 
screen.)  Click on OK.  

8 Now display one page at 100% view. 

9 Leave your document on screen for the next exercise. 
 

Zoom level Zoom 
Out 

Zoom 
In 

Zoom 
slider 
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Cursor Movements 
The mouse pointer shows as follows on the Microsoft Word screen. 

 The mouse pointer is displayed as an insertion point, sometimes called an I-Beam when it is 
within text.  You can move the insertion point to the location required, then click the left 
mouse button to set the cursor at that position.   

 The pointer changes to a left pointing arrow when it is moved to the scroll bars, Status Bar, 
or to the top part of the screen. 

 

The table below shows quick cursor movements for both the mouse and keyboard shortcuts. 
 

Cursor Position Mouse Keyboard Shortcut 

A character at a time Move mouse and click Right  or Left  

A word at a time Move mouse and click Ctrl  or Ctrl  

Beginning of line Move mouse and click Home 

End of line Move mouse and click End 

A line at a time Move mouse and click Up or Down  

Down one paragraph Move mouse and click Ctrl  

Up one paragraph Move mouse and click Ctrl  

Bottom of current window Move mouse and click Alt Ctrl Page Down 

Top of current window Move mouse and click Alt Ctrl Page Up 

Down one window Click below Vertical Scroll Box Page Down key 

Up one window Click above Vertical Scroll Box Page Up key 

Down one page *  Click on  at bottom right of screen  Ctrl Page Down 

Up one page *  Click on  at bottom right of screen  Ctrl Page Up 

Beginning of document # Drag the Vertical Scroll box to the top of the 
Vertical Scroll Bar and click  Ctrl Home 

End of document #  Drag the Vertical Scroll box to the bottom of 
the Vertical Scroll Bar and click  Ctrl End 

 
The scroll wheel on the mouse can be used to quickly scroll through your document. 

Go To 
The Go To feature allows you to move to a specific page (or other location) in your document.  
Simply press Ctrl G OR click on the page number shown on the Status Bar at the bottom of the 
screen, enter the page number then click on Go To.  Click on Close. 
 
* Select Browse Object   

If you cannot move up or down a page at a time click on the Select Browse Object button  at the 
bottom right corner of the Microsoft Word screen and select the Browse by Page option .  When 
you click on the  (Next Page) and  (Previous Page) buttons you will then be able to move a 
page at a time through your document. 
 

# See below   

 * See below  

Ctrl G 
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# Vertical Scroll Box 

The Vertical Scroll Box can be dragged up or down on the Vertical 
Scroll Bar to display a page indicator.  When you release the 
mouse button the page will be displayed. 

 
Status Bar 
The Status Bar at the bottom left of the screen displays 
information about the document on screen, ie the page you are 
on, the number of pages, number of words and the dictionary used. 
 
Exercise 11 

1 With the document called Africa on screen practise moving the cursor around the document, 
using both mouse and keyboard shortcuts shown on the previous page. 

2 Which is the quickest way to move the cursor - 

 to the end of a document ..........................................................................................................  

 to the end of a line ....................................................................................................................  

 to page 3 ...................................................................................................................................  

3 The Status Bar shows the following information: ....................................................................  

 ..................................................................................................................................................  

4 Close the document.  Do not save any changes. 
 

Saving changes to the document on screen and 
retaining the original document 

Sometimes when you make editing and/or formatting changes you will want to retain your original 
document and save the edited document with a new file name.   
 
Exercise 12 

1 Open the file called Triathlon. 

2 Press Ctrl End. 

3 Press Enter then type the following: 

 
Training requirements increase as the triathlete works his or her way up the fitness 
chain. A sprint version requires the athlete to swim 750 metres, bike 20 km and 
run 5 km.  You can then proceed to do a Half Ironman if desired. 

4 Click on  and click on . 

5 In the File name: box, on top of the existing file name, type a new name for your document, ie 
Training Requirements. 

6 Click on  so the changes made are saved to the new document only.  (The original 
document is therefore retained on file.) 

7 Zoom to 75%. View your document as Page Width (use the View tab). 

F12 
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